Instrukcja do ¢wiczenia:

Serwonaped



Celem niniejszego ¢wiczenia jest opanowanie podstaw obstugi systemu

Z serwonapedem, a w szczegolnosci:

. uruchamianie serwonapedu

. wykonanie ruchu referencyjnego
. sterowanie predkoscig

. sterowanie pozycjg,

Cwiczenie 1

Uruchamianie serwonapedu

Aby prawidtowo i bezpiecznie uzytkowa¢ uktad konieczne jest zapoznanie sie
z aplikacjag Wmemoc oraz poczatkowymi ustawieniami niezbednymi do poprawnej pracy
uktadu.

Wprowadzenie

W ¢éwiczeniu tym nauczysz sie:

. ustanawia¢ komunikacje pomiedzy komputerem PC a modutem SEC-AC,

. ustawia¢ opcje programu Wmemoc oraz wczytywac zestaw ustawien Festo,

. przeprowadzi¢ reczne sprawdzenie sprzetu,

. sprawdzac ustawienia okien dialogowych ,Command” oraz ,Reference Position”,

. aktywowac system serwonapedu.



Rysunek 1: Zmontowany uktad serwonapedu z silnikiem bezszczotkowym.

Szczegobtowe instrukcje.

Zanim wigczysz zasilanie sprawdz czy panel sterowania sg podtgczone do kontrolera

)

(nie uruchamiaj jeszcze aplikacji Wmemoc
Gtéwny wytacznik zasilania jest w pozycji OFF.

W dol jest WYLACZONE

Rysunek 2: Gtowny wiqcznik zasilania.



Sprawdzenie panelu.

Przetacznik (Regler) jest wytaczony (pozycja w dot - OFF) — zielona dioda zgaszona.
Wzmacniacz mocy mocy (Endst.) jest wytaczony (pozycja w dét - OFF) — zielona dioda
zgaszona. Wszystkie inne przetgczniki sg wytgczone (pozycja w dot), a potencjometry sg

ustawione na pozycje zerowe.
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Rysunek 3: Panel sterowania.

Zataczenie zasilania
Element napedzany powinien znajdowac sie w srodkowym potozeniu.
Zasilanie zatgczamy zawsze w nastepujacej kolejnosci:
. napiecie gtowne (~230V),
. napiecie pomocnicze 24V,

Po przeprowadzeniu auto testu na przodzie modutu SEC-AC zaswieci sie dioda READY.

Uwaga : Wylaczanie ukltadu w odwrotnej kolejnosci



Jesli pojawig sie komunikaty o btedach, popraw:

Btad Procedura

Error 2 Sprawdz zasilanie uktadu SEC-AC. Upewnij sie, ze wigczasz uktady
w odpowiedniej kolejnosci.

Error 3 Sprawdz potgczenia silnika; kabel do serwonapedu. Jesli to
konieczne wyjmij go poditgcz ponownie.

Ustanowienie komunikacji miedzy PC a SEC-AC

Uruchom program Wmemoc na komputerze PC (jesli wystartujesz go wczesniej pojawi
sie komunikat btedu). Jesli komunikacja dziata to program Wmemoc uruchomi sie z trzema

otwartymi oknami — ,Commands”, ,Status” oraz ,Actual Values”.

=, WMEMOC 3.3 (R) =13
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Rysunek 4: Okno aplikacji Wmemoc.




Ustawianie opcji programu Wmemoc.

Wybierz z gtébwnego menu pozycje ,Actual Values”. Zaznacz wszystkie opcje, co
spowoduje ich aktywacje w oknie ,Actual Values”.

~, WMEMOC 3.3 (R)

File W-TSERENEN Set Points  Analog monitor

- v Motorspeed
v Torgque

v Mokor Current
v Rotor position
v Temp. power stage
( v Position Counter
v Power dissipation and DC-bus voltage

Rysunek 5: Wybor wyswietlanych wielkosci.

Wybierz Options > User Mode > Expert. W ten sposéb bedziesz miat dostep do

wszystkich funkcji programu Wmemoc.

User level

Uszer level

" Beginner

" Advanced

(+ Expert

Rysunek 6: Wybor trybu pracy.



Wczytanie zestawu ustawien.

Wybierz Select File > Parameter Set > Read from file and store into servo.

Actual walues  Set Points  Analog monitor  Parameters Error Options  Help

Parameter set 2 Read from File and store inko servo

Read from servo and skore into File

Firmware-Download

Rysunek 7: Wczytanie zestawu ustawien.

W oknie eksploratora znajdz odpowiedni zestaw parametrow. Powiniene$ go znalez¢é w
katalogu

C:\Programme\Festo\wmemoc\wpa\Motor\MTR-AC- 55\horizontal

Wybierz zestaw parametrow odpowiedni dla silnika i modutu liniowego DGE, ktérych
uzywasz, upewniajgc sie, ze wybrates odpowiednig pozycje (poziomg — horizontal lub
pionowg - vertical)

Uwaga:

Wczytane parametry sg automatycznie zapisywane w pamieci EEPROM, natomiast
zmiany parametréw muszg zosta¢ zapisane do EEPROM.

Load from disk

File selection

v’ OK
[) DGE12ZR-AC55-3s-Ax_h.w A | [= Festo ~ X  Cancel
[ DGE18SP-AC55-35-Ax_h'w (= wmemoc B
I DGE18ZR-AC55-35-Ax_hV = wpa ?  Help
[) DGE25RF-AC-55-35-Gx_h.} — (== Motor
[) DGE25SP-ACS5-35-Ax_h.w (£ MTR-AC-55
[) DGEA18ZR-ACS5-35-Gx_h. i horizontal
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|WMemoc-Parameter (~wpa] v | |E= d: [system] -

File description:

Group:
Controller type | v Standard values
Motor type: |
— v Destination data
Description: |
D ate: | v CAM-parameters

Rysunek 8: Wezytanie parametrow.



~ . WMEMOC 3.3 (R)

FIEN Actual values  Set Points  Analog monitor  Parameters Error  Options  Hr

Parameter sek r Fead from file and store into servo

) Read from servo and store into File
Firmware-Download

Rysunek 9: Odczyt parametrow z pamieci EEPROM.

Nacisnij OK i wczytaj zestaw parametrow. Pojawi sie wskaznik postepu wczytywania,

ktére zajmie okoto 50s. Po zakonczeniu ujrzysz komunikat ,Data transferred”.

Uwaga:

Kontroler zostat witasnie zaopatrzony w kompletny zestaw predefiniowanych
parametréw dla wszystkich kombinacji osie - serwonapedy firmy Festo (dla przypadku
uzycia poziomej i pionowej konfiguracji). Te predefiniowane parametry dajg poczatkowa,
bezpieczng konfiguracje sterownika.

Nastepnie petle sterownika powinny zostac¢ zoptymalizowane do konkretnej aplikaciji.

Zapisywanie zestawu parametrow

Sa dwie mozliwosci zapisania zestawu parametrow:

Wybierz File > Parameter set > Read from servo and save into file.

W ten sposob zapiszesz parametry z pamieci EEPROM modutu SEC-AC do pliku
komputera.

lub

Wybierz Parameters > Save parameters.

Analog monitor

- Offlin Motor Data
Device paramekters  »
Position conkral. ..

Positioning »
Swnchronization. . .

|'|
h

Rysunek 10: Zapis parametrow.

Error ©Options




W ten sposob zapiszesz dane z pamieci ulotnej RAM modutu SEC-AC do jego pamieci
statej EEPROM.
Tylko w ten sposob zmiany parametrow pozostang zapisane w przypadku awarii

napiecia zasilania 24V.
Reczna kontrola sprzetu.
Sprawdz wartos¢ w okienku ,Position” poprzez poruszenie rekg suwaka w dowolnym

kierunku, az do osiggniecia przetgcznika krancowego.

Sprawdz czy licznik pozycji w oknie ,Actual Values” zlicza pozycje w goére i w dot.

Actual values

M otorspeed

Actual value: 0 RPM
Set point: 0 RPH
Torque

Actual value: 0.00 A
Motorcumrent rms 0.00 A
Rotor position: 287 44 °
Temp. power stage: 29 °C
Position: -0.63831 R
Lt motor:
I.t Servo: [ 0z |
DC-bus voltage 3NV

Rysunek 11: Licznik pozycji.

Sprawdz funkcjonowanie wytgcznikéw krancowych.

Jesli licznik liczy w gore, kiedy osiggniesz wytgcznik krancowy, w oknie ,Status”
powinna zaswiecic sie dioda obok tekstu ,Limit switch 17.

Sprawdz na ponizszym rysunku.

Sprawdz to samo w przeciwnym kierunku — licznik powinien odlicza¢ w dotf, a w oknie

~otatus” powinna zaswiecic sie dioda obok tekstu ,Limit switch 0”.



Ready

Under voltage

Output stage enabled
@ Brake locked

In position

lit-examination

Al speed window

(@ Following error
Limit switch 0

O Limit switch 1 L\\k

Rysunek 12: Okno statusu.

Mozliwe problemy

Problem Sposdb rozwigzania

Dioda wytacznika krancowego nie Sprawdz potgczenia

zapala sie po osiggnieciu pozycji| Sprawdz funkcjonowanie wytgcznika krancowego
koncowej Sprawdz logike wytgcznika krancowego

Sprawdz czy na testerze przetaczniki EO i E1 sg w

dolnej pozycji

Kierunek zliczania nie zgadza sie|Fizycznie zamieh wytgczniki krancowe miejscami
Z numeracjq wytgcznika kran-|Kontrola bezpieczenstwa

cowego (zlicz. w goére do wyth.1,

zlicz. w dét do wyt.0)

Uaktywnienie systemu przy pomocy panelu sterowania.

Przetacz koncdéwke mocy (Endst.) do pozycji ON (zapali sie dioda)
Przetacz sterownik (Regler) do pozycji ON (zapali sie dioda)
Na 7-segmentowym wyswietlaczu modutu SEC-AC wyswietla sie litera ,P” (= tryb

pozycjonowania)




Zauwaz, ze suwak jest teraz zablokowany i nie moze by¢ przesuwany. Mozesz teraz

styszeC hatas o wysokiej czestotliwosci dochodzacy z kontrolera.

Sprawdzenie ustawien dla trybu pozycjonowania w oknie dialogowym

,commands”

Otworz okno dialogowe ,Commands” i upewnij sie, ze nastepujace ustawienia sg

aktywne ()

. Drive enable

. Motor speed control
. Position control

. Positioning

v Drive enable:

" Torque control

{* Motor speed control

[~ Set point ramp
v Position Control
|v Positioning

[~ Synchronization

Rysunek 13: Okno dialogowe
,,Commands”.

Ruch referencyjny serwonapedu.

Do prawidtowej pracy serwonaped potrzebuje tzw. pozycji odniesienia, wzgledem ktorej
liczone sg wszystkie inne potozenia.
Pozycja odniesienia ustalana jest w ruchu referencyjnym po uruchomieniu a przed

normalng pracag serwonapedu.



Nacisnij ikone ruchu referencyjnego, aby otworzy¢ okno dialogowe.

Reference position

Destination Acceleration
max. turns % 100.04ms J oK
permitted 121.000000 Total twmo T 5 e
anc
Speed Smoothing 0,00 ms - Help
R T 4 I | [ : —
Cantch 149,6106 RPM
speed:
i o . Deceleration E GO!
Crawl 49.1259 RPM Total time 100,04 ms
speed: ol | > o | r
HUnng 19,1259 BPM Smoothing 0,00 m=s
speed: o | > o | r
Start position Direction: Mode:
7 Tumn left ¢« Method 1
Position: 0000000
= " Turn right " Method 2
Start the reference run
[ will be realised after power and regulator enable

Rysunek 14: Okno ruchu referencyjnego.

W oknie dialogowym ruchu referencyjnego sprawdz, ze zaznaczona jest opcja ,Method
1” w polu ,Mode”. Trzymaj jedng reke na wytaczniku urzgdzenia SEC-AC aby w kazdej
chwili moc go wytaczy¢, gdyby wystapit jakis biad.

. zatgcz Panel sterujacy,
. zatgcz kontroler,
. uruchom ruch referencyjny, klikajac w oknie dialogowym ruchu referencyjnego,

. przycisnij przycisk ,GO!”
Suwak poruszy sie do punktu referencyjnego a nastepnie zatrzyma. Jesli system jest
zbyt gtosny lub ruch jest nierownomierny wytgcz kontroler i zgtos btgd prowadzgcemu

zajecia.



Nastawianie pozycji, predkosci oraz nachylen charakterystyk serwonapedu

W ¢wiczeniu tym nauczysz sie
Odczytac zestaw zdefiniowanych pozycji.
Wybiera¢ pozycje uzywajgc okna dialogowego ,,Go to Destination” (IdZz do celu).

Trzech sposobdw poruszania pomiedzy poszczegolnymi pozycjami.

4 predkosc V

e N\

I pozycja 1

[
1
1
I
1
1
1
I
1
1
1
1
I
1
1
I
I
1
I
1
1
I
1
1

pozycja 2 €Zas t

Rysunek 16: Przyktadowy przebieg ruchu napedu.

W polach okienek przyspieszania (,Acceleration”) oraz hamowania (,Deceleration”)
mozesz sparametryzowa¢ nachylenia charakterystyk predkosci dla rozpedzania
i hamowania napedu. Jesli czasy w polu ,Smoothing” zostang ustawione na zero to

nachylenia bedg liniowe, w innym wypadku bedg to funkcje paraboliczne.
Sprawdzanie pozycji
Uwaga: nie musisz wprowadzac pozycji — zestaw pozycji zostat wczytany jako czesé
zbioru parametrow. W cwiczeniach uzywasz predefiniowanych pozycji, predkosci

i charakterystyk — niektére z nich bedziesz modyfikowac.

Nacisnij ikone celu ,Destination”.

Rysunek 17: Ikona celu.



Pojawi sie okno dialogowe ,Destination 0”.

Select Destination Acceleration
" CAN-BUS e 400,2 ms
Position:  |_p 500000 R 3 ’
~ RS-232 [ Total time r | E =
i* Pos0 Speed c " T —
" Pos 1 ) 1100,0000 RPI moothing o me
~ Pos 2 Running o - o | »
speed =
™~ Pos 3 Deceleration
~ Pos 4 0,0000 RPM W
Final speed - h
~ Pos 5 a| I » Total time a0 =
" Posb Torque feed forward
q Smoothing 400,2 ms
" Pos 7
Factor 0 o | >
™ Pos 8
 Pos 9 Positioning run Messages
+ relative
" Pos10 e Remainin
‘- ; o q |0,000000 R
~ Pos 11 - 2::;::;: to last destination distance I
" Pos 12 Remaining |0,0 ms
~ Pos13 Start during positioning run time
- Pos 14 * wait for End of positioning run Options
i " Interrupt actual positioning run )
" Pos15 " lgnore start command [ Synchronized
v K | X Cancel ?  Hep B Cowy ‘ i Go |

Rysunek 18: Okno dialogowe pozycji.

Ponizsza tabela przedstawia pozycje zdefiniowane w zestawie wczytanym do

kontrolera
Nr. pozycji | Pozycja Predkos¢ Tryb Czas Czas
(R) ruchu pozycjono | przyspieszenia | op6znienia
[obr/min] waniax [ms] [ms]
0 -0,5 100 Abs 400 400
1 -4,3 200 Abs 100 100
2 -4,3 300 Abs 100 100
3 4,3 400 Abs 100 100
4 4,3 500 Abs 100 100
5 -1 200 Abs 400 400
6 -2 250 Abs 400 400
7 -3 300 Abs 400 400
8 -4 400 Abs 400 400
9 -4,3 500 Abs 400 400
10 -4,3 500 Abs 100 100
11 -0,5 300 Rel 400 400
12 0,5 300 Rel 400 400




SEC-AC wraz z innymi parametrami. Klikajgc na przyciski kolejnych pozycji mozesz
obejrze¢ nastawy kazdej z nich.
*Zauwaz, ze tryb pozycjonowania (,Positioning mode”) w aplikacji Wmemoc nosi

nazwe ,Positioning run”.
Ruch do wybranej pozycji

Wiacz kontroler (Regler).

Wybierz przycisk ,Go to destination” na pasku narzedzi.

— 0
Rysunek 19: Ikona ,,1dZ do celu”.

Naciskajgc kolejne przyciski w oknie dialogowym mozesz przesuwa¢ naped do
zadanych pozyciji. (Jesli rozpoczynasz bezposrednio po wykonaniu ruchu referencyjnego

suwak powinien by¢ w pozycji referencyjnej).

Destination 0 | Destination 8

Destination 1 Destination 9

Destination 2 | Destination 1 l]‘

Destination 3 | Destination 11 ‘

Destination 4 | Destination 12

Destination 5 | Destination 13

Destination 6 | Destination 1 4‘

Destination 7 | Destination 1 5‘

Reference run ‘

Rysunek 20: Okno ,,1dz do celu”.

Wybierz pozycje w kolejnosci przedstawionej w ponizszej tabeli. Odznaczaj kolejne
wykonane ruchy w kolumnie ,Krok”, a w prawej kolumnie réb notatki ze swoich obserwacji

ruchu suwaka.



